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                                     BY JOHN BERRYMAN 

 

About the Poet- John Berryman 
 Born on October 25, 1914 in Oklahoma, America.  

 His real name was John Allun Smith Jr. 

 He received his education from Columbia University and University of Cambridge. 

 He was a major figure in American poetry in the second half of the 20th century. 

 He was considered to be a key figure in the Confessional School of Poetry. 

 His best known work is ‘The Dream Songs’. 

 He died on January 7, 1972. 

About the Poem 

 The little boy has lost his ball. 

 He can buy many new balls but he has a very deep emotional attachment and memories 

associated with that ball. 

 So he regrets over the loss of the ball. 

 The poet is indirectly trying to tell us that we should learn how to cope up with the loss. 

 And money is external i.e. we can’t buy memories with money. 

 We all should learn our responsibility and learn to cope up with the loss. 

 
 

 

Extract Based Question (Solved)  
1.“What is the boy now, who has lost his ball,  

What, what is he to do? I saw it go  

Merrily bouncing, down the street, and then  

Merrily over – there it is in the water!” 

  

(a) What has happened to the boy? 

(b) Why does the poet say ‘No use to say – ‘O there are other balls’? 

(c) Which word means ‘happily’? 

(d) Where did the ball go? 

Message Rhyme Scheme Literary Devices 

   Nothing is 

permanent in 

life. We must be 

mentally 

prepared to face 

any loss in life. 

 

The poem is 

having no 

particular rhyme 

scheme.  

 Assonance – boy now who lost 

 Alliteration – roaming round 

 Repetition – ‘what’ is repeated 

 Imagery – merrily bouncing down the street 

 

 



Answers: 
(a) The boy was very sad as he had lost his ball. 

(b) The poet says so as the loss of the ball is of a major consequence to the boy. 

(c) Merrily means happily. 

(d) The ball went to the water. 
 

2.“No use to say – ‘O there are other balls’ 

An ultimate shaking grief fixes the boy 

 As he stands rigid, trembling, staring down 

 All his young days into the harbour where  

His ball went. 

 I would not intrude on him, A dime, another ball, is worthless.” 

(a) Where had the boy’s ball gone? 

(b) How has the loss affected the boy? 

(c) Why was ‘he’ trembling, staring down? 

(d) Why is the another ball worthless for the boy? 

Answer: 
(a) The boy’s ball went into the dark waters of the harbour. 

(b) The boy is very much troubled at the loss of his ball. He stands still, trembling and staring 

at his ball. 

(c) He was trembling, staring down as he had lost his ball. 

(d) he starts understanding his responsibility. 

 

Extract Based Question (Unsolved)   
1.“……………Now 

He senses first responsibility 

In a world of possessions. People will take 

Balls, balls will be lost always, little boy. 

And no one buys a ball back. Money is external.”  

(a) What does the boy understand? 

(b) What does the word ‘balls’ signify? 

(c) What is meant by the word ‘possessions’? 

(d) What does “In a world of possessions mean?” 

 

2.“He is learning, well behind his desperate eyes, 

The epistemology of loss, how to stand up 

Knowing what every man must one day know 

And most know many days, how to stand up.” 

(a) What is the boy learning? 

(b) Why are boy’s eyes desperate? 

(c) What do you mean by ‘epistemology of loss’? 

(d) What every man needs to know one day? 

 

Short Answer Type Questions (Solved) 

Q1: What message does John Berryman want to convey through this poem? 

 The message that the poet wants to convey is the importance of loss and responsibility 

in life. 

 We should not forget the importance of possessions. 

 



Q2:  How does the boy feel at the loss of his ball? 

 The boy is very much troubled at the loss of his ball.  

 His ball falls in water. 

 He is much upset as he has a long association with the ball. 

 

Q3: “Money is external.’ What does the poet mean by this expression? 

 He makes the boy understand about his responsibility as the loss is immaterial. 

 He can purchase another ball. 

 He explained that the world is full of possessions and money is an external item. 

 

Short Answer Type Questions (Unsolved) 

1. How can you distinguish between a hyena and a crocodile? 

2. What are the distinctive features of the Asian lion as given in the poem? 

3. What does the Bengal Tiger look like? What is so distinct about him? 

4. How does a leopard behave when he sees someone?  

5. How does the poet describe the bear?.    

 

Long Answer Type Questions (Solved) 

1.Why is it important for everyone to experience loss and to stand up after it?  

 It is important for everyone to experience loss and to stand up after it in order to be 

strong and to get on with life. 

  One needs to stay strong no matter how much it hurts inside.  

 Staying strong is the only way to survive. 

  Moreover, one needs to learn to accept and let go and not cling to something that they 

can never have. 

 One should understand that the past is gone and it will never come back.  

 Experiencing loss sometimes helps us to grow up and face hardships, like loss. 

  This helps us in breaking all the boundaries into freedom. 

 

 Long Answer Type Questions (Unsolved) 
1. Why did the boy feel so sad at the loss of his ball? 

2. Why did the poet not offer the boy money to buy another ball? 

3. Why does the poet think that it is useless to give the following suggestion to the boy? 

‘No use to say- ‘O there are other balls’: 
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How to Create More Employment? 
1. To remove open unemployment, underemployment and disguised 

unemployment, there is a need to create more employment opportunities.  

More employment opportunities can be created by: 



¤ Provision of infrastructure facilities like irrigation in rural areas: 

Construction of dams and canals will generate many more jobs. Moreover, 

this will make agriculture more productive. Farmers can raise two or more 

crops during a year, i.e., they will remain employed throughout the year. 

¤ Expansion of transport and trade in rural areas: Building of roads, store 

houses and other such facilities again will have two effects. One, it will 

immediately create new employment opportunities and, two, it will add to 

the income of the farmers. 

¤ Provision of cheap and easy credit facilities: If the farmers are provided 

loans at low rate of interest, they would be in a position to buy seeds, 

fertilisers, agricultural equipment, etc. A prosperous agriculture will create 

more employment opportunities. 

¤ Setting up of industries and services in semi-rural areas: These enterprises 

can provide employment in those seasons when there is no work in 

agriculture. 

¤ Construction of school buildings, health centres, etc.: These would not only 

create more employment opportunities but also' contribute to human 

development. 

¤ Promotion of activities like tourism, regional crafts, information, etc., can 

result in creation of more employment opportunities. 

2. Our constitution has guaranteed some fundamental rights to all the citizens of 

the country. One such right is the Right to work, i.e., every person has a right to 

demand a paid job from the government. 

3. In recognition of this Right to work, the Government has enacted the National 

Rural Employment Guarantee Act, 2005. Under this Act, 

¤ All those persons who are able and willing to work have been guaranteed 

100 days of employment in a year by the government. 

¤ If the government fails to provide employment, it will have to provide 

unemployment allowance to affected persons. 

 

Assignments 

 

1) What is the full form of GDP?  (1) 

2) Give the meaning of Gross Domestic Product. (1) 

3) Who undertakes the mammoth task of measuring GDP in India?  (1) 

4) Give one reason for the rapid growth of service sector in India.  (1) 

5) Which sector was the largest producing sector in 1973-74 in India? 

 (1) 

6) Which was the largest producing sector in 2013-14 in India?  (1) 

7) Which sector had the highest percentage of employment during 

1973-74? (1) 



8) Which sector had the highest percentage of employment in 2013-

14.  (1) 

9) Which sectors have huge potential for generation of employment in 

India?  (1) 

10) Explain with example the method of calculating Gross Domestic 

Product. Why are only 'final goods and services' counted in G.D.P.? 

[2014, 2013, 2012]  (5) 

11) Describe the historical changes that have taken place in the sectors 

of the economy in the developed countries. [2012, 2015]  (5) 

12) "When a country develops, the contribution of primary sector 

declines and that of secondary and tertiary sector increases." 

Analyse the statement. [Board Term-I, (58), DDE-2014, 2012]  

OR 

"The declining share of agriculture in the Gross Domestic Product 

(GDP) is a matter of serious concern in India". Support the 

statement with any five reasons. [2016-17, 2010]  (5) 

13) Explain any three reasons for the Primary Sector to be the largest 

employer in India. [2015]  (3) 

14) What is the significance of secondary sector in Indian economy? 

How does it help in the economic development of the country? [ 

2011]  (5) 

15) Why is the tertiary sector becoming more important in India? 

Explain by giving four reasons. [2016-17, 2013, 2012, 2011, 2010] 

 (5) 

OR 

Why is the tertiary sector growing so rapidly in India? Explain it 

with four reasons. [2010] 

16) 'All of the service sector is not growing equally well in India." 

Justify the statement with three arguments. [2013]  (3) 

OR 

Service sector in India employs two types of people. Explain by 

giving suitable examples. [2011]  (3) 



17) 'Tertiary sector is not playing any significant role in the 

development of Indian economy." Do you agree? Give reasons in 

support of your answer. (5) 

18) The following table gives the GDP in Rupees (Crores) by three 

sectors: (3) 

 

Year Primary  Secondary  Tertiary  Total GDP 

2000 52,000 48,500 1,33,500 2,34,000 

2013 8,00,500 10,74,000 38,68,000 57,42,500 

 
(i) Calculate the share of the three sectors in GDP for 2000 and 2013. 

(ii) Show the data as a bar diagram similar to Graph 2 in the chapter. 

(iii) What conclusions can we draw from the bar graph? 
 

 

 

 

 

Assignment 

1) Which sectors have huge potential for generation of employment in 

India?  (1) 

2) When was MGNREGA implemented?  (1) 

3) Give full form of MGNREGA?  (1) 

4) How many days of employment per year are guaranteed to one 

person in every poor rural household?  (1) 

5) Which types of activities are given preference in MGNREGA?  (1) 

6) In which sector is seasonal and disguised unemployment most 

prevalent in India? [2016-17, 2015]  (1) 

7) Explain the term 'unemployment'.  (1) 

8) What do you understand by disguised unemployment? Explain with 

an example each from the urban and rural areas. [2016-17, 2014, 

2010] (3) 

OR 

Explain the concept of under employment taking example from 

some non-agricultural field. [2014]  (3) 

9) Distinguish between open unemployment and disguised 

unemployment. (5) 



10) How to create more employment in rural areas? Explain with the 

help of five suitable examples. [2012, 2011, 2010]  (5) 

OR 

How would income and employment increase if farmers are provided 

with loan, irrigation and transportation facilities? [Board Term-I, 

(36, 37), 2012]  (3) 

11) Describe the various ways in which government can create 

employment opportunities for the people of India. [2016-17, 2012, 

2011]  (5) 

OR 

In what ways can employment be increased in urban areas? 

12) Describe any five provisions of 'Mahatma Gandhi National Rural 

Employment Guarantee' Act 2005. [2016-17, 2014, 2012]  (5) 

OR 

Why do you think MGNREGA 2005 is referred to as 'Right to work'? 

 

Class X  

Geography Study Material  

Millets: 

→ Jowar, bajra and ragi are the important millets grown in India. 

→ These have very high nutritional value. 

 

• Pulses: 

→ India is the largest producer as well as the consumer of pulses in the world. 

→ Major source of protein in a vegetarian diet. 

→ These need less moisture and survive even in dry conditions. 

→ Major producing states in India are Madhya Pradesh, Uttar Pradesh, 

Rajasthan, Maharashtra and Karnataka. 

Oil Seeds: 



→ The oil seeds covers approximately 12 percent of the total cropped area of 

the country. 

→ These are used as cooking mediums as well as used as raw material in the 

production of soap, cosmetics and ointments. 

 

Questions: 

1. Which ia the most important occupation in India ? 

2. Which country is the largest producer of rice in the world? 

3. In which country slash & burn is called “Humah” ? 

4. Which state is the largest producer of rice in India? 

5. Which state is the largest producer of wheat in India? 

6. Which state is the largest producer of sugarcane in India? 

7. Which country is the largest producer of wheat in the world? 

8. Which crops are included in millets ? 

 



Activity: Mark major wheat & rice producing states in 

India(use different color or pattern for wheat & rice )

 
 

 

 

 



SUBJECT: HISTORY 

CHAPTER: 1 

  

Write the answer of  Following Questions not more than 100 words ( carry 5 marks)  

1. Briefly explain the process of Unification Italy? 
2. What was Zollverin ? Why was it formed ? 
3. How did the polish language work as a symbol of struggle against Russian dominance? 
4. Explain the Napoleonic Code.  
5. Examine the a Nation State a Building process in a Germany after 1848. 
6. Analyse the measures and practices introduced by the French revolutionaries to create a 

sense of collective identity amongst the French people.  
7. How was Europe closely allied to the ideology of liberalism ? 
8. Explain the statement “ When France sneezes , the rest of Europe catches cold .  
9. Who were Marianne and Germanis ? What was the importance of the way in which they were 

portrayed?  
10. Why did nationalist tension emerge in the Balkans ? 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



POLITICAL SCIENCE 

 

 
 

 



CHEMISTRY 
CLASS 10 

METALS AND NON-METALS 

 

 

Reactivity Series 
The series in which metals are arranged in the decreasing order of reactivity, it is known as Reactivity Series. 

 

Fig.1. Reactivity Series 

 

Ionic Compounds 
Compounds formed due to the transfer of electrons from a metal to a non-metal are known as Ionic 

Compounds. 

 

 

Properties of Ionic Compounds 

 They are generally hard and solid. 

 They have a high melting and boiling point. 

 They are soluble in water but insoluble in inorganic solvents such as ether etc. 

 They are conductors of electricity in molten and solution state. 



Reason—Ions can not move due to rigid solid structure. Ionic compounds conduct 

electricity in molten state. 

Reason--  Ions can move freely since the electrostatic forces of attraction between 

the oppositely charged ions are overcome due to heat. 

  

 BIOLOGY 

Topic : Control and co-ordination (C6) 

Class X 

 

1. What is the role of gustatory and olfactory receptors? What will happen if you try to taste food 

with your nose pressed with hands? 

2. Why is control and coordination system necessary in organisms? 

3. What happens at the synapse between two neurons? 

4. In a synapse, chemical signal is transmitted from 

(a) dendritic end of one neuron to axonal end of another neuron 

(b) axon to cell body of the same neuron 

(c) cell body to axonal end of the same neuron 

(d) axonal end of one neuron to dendritic end of another neuron 

 

5.In a neuron, conversion of electrical signal to a chemical signal occurs at/in 

(a) cell body 

(b) axonal end 

(c) dendritic end 

(d) axon 

 

6. Draw the structure of a neuron and explain its function. 

7. With the help of a flow chart, explain the transmission of information to a neuromuscular 

junction. 

8. What are reflex actions and reflex arc? What is its significance? 

9. Draw well labelled diagram of a reflex arc on touch of an hot object. 
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HINDI 

पदबंध (Phrase) की परिभाषा 

पद- वाक्य से अलग िहने पि 'शब्द' औि वाक्य में प्रयुक्त हो जाने पि शब्द 'पद' कहलाते 

हैं। 

दूसिे शब्दो ंमें- वाक्य में प्रयुक्त शब्द पद कहलाता है। 

 

पदबंध- जब दो या अधधक (शब्द) पद धनयत क्रम औि धनश्र्चित अर्थ में धकसी पद का 

कायथ किते हैं तो उन्हें पदबंध कहते हैं। 

दूसिे शब्दो ंमें- कई पदो ंके योग से बने वाक्यांशो को, जो एक ही पद का काम किता है, 

'पदबंध' कहते है। 

डॉ० हिदेव बाहिी ने 'पदबन्ध' की परिभाषा इस प्रकाि दी है- वाक्य के उस भाग को, 

धजसमें एक से अधधक पद पिस्पि सम्बद्ध होकि अर्थ तो देते हैं, धकनु्त पूिा अर्थ नही ंदेते- 

पदबन्ध या वाक्यांश कहते हैं। 

जैसे- 

 

(1) सबसे तेज दौड़ने वाला छात्र जीत गया। 

(2) यह लड़की अतं्यत सुशील औि परिश्रमी है। 

(3) नदी बहती िली जा िही है। 

(4) नदी कल-कल किती हुई बह िही र्ी। 

 

उपयुथक्त वाक्यो ंमें काला छपे शब्द पदबंध है। पहले वाक्य के 'सबसे तेज दौड़ने वाला 

छात्र' में पााँि पद है, धकनु्त वे धमलकि एक ही पद अर्ाथत संज्ञा का कायथ कि िहे हैं। दूसिे 

वाक्य के 'अतं्यत सुशील औि परिश्रमी' में भी िाि पद हैं, धकनु्त वे धमलकि एक ही पद 

अर्ाथत धवशेषण का कायथ कि िहे हैं। तीसिे वाक्य के 'बहती िली जा िही है' में पााँि पद हैं 

धकनु्त वे धमलकि एक ही पद अर्ाथत धक्रया का काम कि िहे हैं। िौरे् वाक्य के 'कल-कल 

किती हुई' में तीन पद हैं, धकनु्त वे धमलकि एक ही पद अर्ाथत धक्रया धवशेषण का काम 

कि िहे हैं। 

 



इस प्रकाि ििना की दृधि से पदबन्ध में तीन बातें आवश्यक हैं- एक तो यह धक इसमें एक 

से अधधक पद होते हैं। दूसिे ये पद इस तिह से सम्बद्ध होते हैं धक उनसे एक इकाई बन 

जाती है। तीसिे, पदबन्ध धकसी वाक्य का अंश होता है। 

 

अाँगिेजी में इसे phrase कहते हैं। इसका मुख्य कायथ वाक्य को स्पि, सार्थक औि 

प्रभावकािी बनाना है। शब्द-लाघव के धलए भी इसका उपयोग धकया जाता है- खास तौि 

से समास, मुहाविो ंऔि कहावतो ंमें। ये पदबंध पूिे वाक्य नही ंहोते, बश्र्ि वाक्य के 

टुकड़े हैं, धकनु्त धनश्र्चित अर्थ औि क्रम के परििायक हैं। धहंदी व्याकिण में इनपि अभी 

स्वतन्त्र अध्ययन नही ंहुआ है। 

 

पदबंध के भेद 

मुख्य पद के आधाि पि पदबंध के पााँि प्रकाि होते हैं- 

(1) संज्ञा-पदबंध 

(2) धवशेषण-पदबंध 

(3) सवथनाम पदबंध 

(4) धक्रया पदबंध 

(5) अव्यय पदबंध 

(1) संज्ञा-पदबंध- वह पदबंध जो वाक्य में संज्ञा का कायथ किे, संज्ञा पदबंध कहलाता है। 

दूसिे शब्दो ंमें- पदबंध का अंधतम अर्वा शीषथ शब्द यधद संज्ञा हो औि अन्य सभी पद 

उसी पि आधश्रत हो तो वह 'संज्ञा पदबंध' कहलाता है। 

 

जैसे- 

(a) िाि ताकतवि मजदूि इस भािी िीज को उठा पाए। 

(b) िाम ने लंका के िाजा िावण को माि धगिाया। 

(c) अयोध्या के िाजा दशिर् के िाि पुत्र रे्। 

(d) आसमान में उड़ता गुब्बािा फट गया। 

उपयुथक्त वाक्यो ंमें काला छपे शब्द 'संज्ञा पदबंध' है। 



 

(2) धवशेषण पदबंध- वह पदबंध जो संज्ञा अर्वा सवथनाम की धवशेषता बतलाता हुआ 

धवशेषण का कायथ किे, धवशेषण पदबंध कहलाता है। 

दूसिे शब्दो ंमें- पदबंध का शीषथ अर्वा अंधतम शब्द यधद धवशेषण हो औि अन्य सभी पद 

उसी पि आधश्रत हो ंतो वह 'धवशेषण पदबंध' कहलाता है। 

 

जैसे- 

(a) तेज िलने वाली गाधड़यााँ प्रायः देि से पहुाँिती हैं। 

(b) उस घि के कोने में बैठा हुआ आदमी जासूस है। 

(c) उसका घोड़ा अतं्यत संुदि, फुितीला औि आज्ञाकािी है। 

(d) बिगद औि पीपल की घनी छााँव से हमें बहुत सुख धमला। 

उपयुथक्त वाक्यो ंमें काला छपे शब्द 'धवशेषण पदबंध' है। 

 

(3) सवथनाम पदबंध- वह पदबंध जो वाक्य में सवथनाम का कायथ किे, सवथनाम पदबंध 

कहलाता है। 

उदाहिण के धलए धनम्नधलश्र्खत वाक्य देश्र्खए- 

 

धबजली-सी फुिती धदखाकि आपने बालक को डूबने से बिा धलया। 

शिाित किने वाले छात्रो ंमें से कुछ पकड़े गए। 

धविोध किने वाले लोगो ंमें से कोई नही ंबोला। 

उपयुथक्त वाक्यो ंमें काला छपे शब्द सवथनाम पदबंध हैं क्योधंक वे क्रमशः 'आपने' 'कुछ' 

औि 'कोई' इन सवथनाम शब्दो ंसे सम्बद्ध हैं। 

 

(4) धक्रया पदबंध- वह पदबंध जो अनेक धक्रया-पदो ंसे धमलकि बना हो, धक्रया पदबंध 

कहलाता है। 

धक्रया पदबंध में मुख्य धक्रया पहले आती है। उसके बाद अन्य धक्रयाएाँ  धमलकि एक समग्र 

इकाई बनाती है। यही 'धक्रया पदबंध' है। 



 

जैसे- 

(a) वह बाजाि की ओि आया होगा। 

(b) मुझे मोहन छत से धदखाई दे िहा है। 

(c) सुिेश नदी में डूब गया। 

(d) अब दिवाजा खोला जा सकता है। 

उपयुथक्त वाक्यो ंमें काला छपे शब्द 'धक्रया पदबंध' है। 

 

(5) अव्यय पदबंध- वह पदबंध जो वाक्य में अव्यय का कायथ किे, अव्यय पदबंध 

कहलाता है। 

इस पदबंध का अंधतम शब्द अव्यय होता है। उदाहिण के धलए धनम्नधलश्र्खत वाक्य देश्र्खए- 

 

अपने सामान के सार् वह िला गया। 

सुबह से शाम तक वह बैठा िहा। 

इन वाक्यो ंमें काला छपे शब्द अव्यय पदबंध हैं। 

 

 

ASSIGNMENT 

Subject - IT 

 

Session 1 - MODIFYING LAYOUT OF A PARAGRAPH SESSION 

1. _______________ can be used to break continuous text to one or more sentences. 

2. Paragraph group is available under _____________. 

3. Default tab stop position is __________ 

 

Session 2 - MANAGING HEADERS 

1. ______________ can be used for inserting information at the top of each page automatically. 

2. Header option is available under ____________ group in Insert Tab. 



 

Q1 – List any five items that can be added to the header area. 

 

 

Session 3 - MANAGING FOOTERS 

1. ______________ can be used for inserting information at the bottom of each page automatically. 

2. The Footer option is available under ____________ group in the Insert Tab. 

 

Session 4 - MANAGING STYLES 

1. __________ are customized options for creating professional looking documents with the 

minimum efforts. 

2. You can change styles by using the ____________ group under the Home tab. 

 

Session 5 - DOCUMENT TEMPLATE 

1. Templates or document templates refer to a __________________ document. 

2. Creating a new document based on a _____________ can save you ____________ because 

_____________________________. 

 

Session 6 - WORKING WITH PAGE AND SECTION BREAKS 

1. _____________ & _________ breaks can be used to separate a document into sections. 

2. Using page breaks, you can create different ____________________________. 

3. A section break controls the __________ of the document content that ________ it, until it 

reaches another section break. 

4. To see a section/page break, click the ________ button. 

                                                                                   

Session 7 - APPLYING CHARACTER FORMATS 

1. After selecting the text you need to click the _______ in the Font group to make the font size 

larger than the current font size. 

2. To remove the character formatting, select the text and click on ______in the Font group. 

3. On selecting _______________________, the first character in the first word of the selected 

sentence will be converted to Capital Letter. 

4. On selecting _______________________, the first character in all the words of the selected 

sentence will be converted to Capital Letter. 



VIDEO LINKS 

ENGLISH - https://youtu.be/6JEHl0ke5Yc  

HINDI - https://youtu.be/ZucfAP7ePjA  

SANSKRIT - https://youtu.be/2ZVoAxay8gM  

MATHS - https://youtu.be/5Wxf5t2unI8  

https://youtu.be/etQvgB78y8U 

https://youtu.be/krWNNMTC5so  

PHYSICS - https://youtu.be/HLChkxfSUhI  

CHEMISTRY - https://youtu.be/Oh0nv3ErjqU  

BIOLOGY - https://www.youtube.com/watch?v=Eyjr8ggq8YU&t=16s  

https://www.youtube.com/watch?v=eB8vL6E_uwc&t=768s  

COMPUTER - https://youtu.be/5wbv0W_yy6A 

https://youtu.be/1r_72rgqrSQ  

GEOGRAPHY - https://www.youtube.com/watch?v=en8TJorOolw 

 

HISTORY - https://www.youtube.com/watch?v=D19ngSEisDc  

POLITICAL SCIENCE - https://youtu.be/-LIB58kpjnc  

ECONOMICS -  
 

https://www.youtube.com/watch?v=eDPcTNVEd-U 

https://www.youtube.com/watch?v=CFLx_Sl65qM 

https://www.youtube.com/watch?v=4DKaDv5SPp0 

https://www.youtube.com/watch?v=LpaMlD_hA5k&list=PLY7M8elJDmwYsdIKu89kJHJy963VePxgT&i

ndex=4 

https://www.youtube.com/watch?v=x1jHFZUWbCY&list=PLY7M8elJDmwYsdIKu89kJHJy963VePxgT&

index=5 

https://www.youtube.com/watch?v=c2t4eCihfOM&list=PLY7M8elJDmwYsdIKu89kJHJy963VePxgT&i

ndex=6 
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